SAP BI Pattern Book Series

SAP Lumira 2.0 Pattern Book

Abstract:
This pattern book covers the two important workflows in deploying SAP Lumira 2.0
release – Updating the Lumira & Design Studio 1.x add-ons to SAP Lumira 2.0 add-on AND
Converting Lumira & Design Studio 1.x documents to SAP Lumira 2.0 version.
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Disclaimer:

•

This pattern book is for informational purpose only and should not be copied / reproduced
without the written permission of SAP.

•

The information provided in this book is based on the SAP BI Pattern Books project for a
specific set of patterns / use cases executed/applied on a copy of one of our customer’s
actual BusinessObjects landscape within SAP labs environment. Hence, make sure to
review and apply the steps that are applicable to your use cases or patterns, based on
your SAP BusinessObjects BI landscape.

•

Contents of this, or any related document and SAP's strategy and possible future
developments, products, and or platforms directions and functionality that are discussed
in this book are all subject to change and may be changed by SAP at any time for any
reason without notice. Therefore, read the latest official product guides, release notes to
understand the differences before executing any workflow or deploying any software
components.

For further comments and questions, email to SAPEnableBI@sap.com

Version History:
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First release version.
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2.0

Updated version – software download center details updated
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Introduction
What is SAP BI Pattern Books?
SAP BI Pattern Books initiative is aimed at producing technical manuals with step-by-step instructions on
how to deploy, configure, test, and upgrade SAP BusinessObjects BI software using a set of live examples,
use cases, and patterns and how these use cases are technically executed / implemented on our customer
landscapes.

Project Scope
We focus on two major workflows in this pattern book;
1. How can we explain and capture the important steps around updating Lumira 1.x and Design
Studio 1.x add-ons to Lumira 2.0 using a live BI environment?
2. What are the important things to know while getting ready to convert the 1.x documents to
Lumira 2.0 version?
Also, we thought it’s a great opportunity to share with you all the issues, challenges that we faced while
executing this project and importantly, the useful resources that helped complete this project successfully
– all in one place (yes, in one document called Pattern Book).
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BOE System Architecture
Technical Architecture
There is a three-server clustered architecture used in this pattern book project with the separation of
Web, BI and Lumira tiers;

**Note: There is a reason and need to install the full BusinessObjects BI stack on the Lumira Server.
This is explained in the Add-On Update workflow section of this pattern book.

Note: Here, it is important to note down the list of components/features that are running on each
of the nodes in your deployment.

System Specifications
Hardware Specifications:
Software Components & Version:

Lumira Features Installed:

Each server is configured with 8 cores and 16 GB RAM
Operating System – Windows
Web Application Server – Apache Tomcat
BusinessObjects BI Platform – BI 4.2 SP04 Patch 01
Lumira Add-on - Lumira Server for BIP 2.0 SP02 Patch1
Lumira Client ** – SAP Lumira 2.0 SP02 Patch1, Lumira Desktop
1.31.8, Design Studio 1.6 SP05 Patch3
BI Node – RESTful Web Services
Lumira Node – Lumira Server, RESTful Web Services, Schedule
Service
Web Node – Web Applications, Mobile Web Applications
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**Note: The Lumira and Design Studio 1.x versions are relevant before updating the landscape and
Lumira 2.0 plays a role post updating the server add-ons.
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Updating Server Add-on
There are five major steps in this workflow of updating the Lumira 1.x and Design Studio 1.x server addon components to Lumira Server 2.0 add-on;
1.
2.
3.
4.
5.

Performing Add-on Update on Lumira Node
Performing Add-on Update on BI Node
Performing Add-on Update on Web Node
Installing Lumira Discovery
Installing Lumira Designer

Let’s now look at how these steps are executed and the important things to note while executing these
steps.
Note: It is strongly recommended to perform the backup of the entire BI platform before running
the Lumira Server add-on upgrade (update). For more details, refer the SAP Note – 1275068 https://launchpad.support.sap.com/#/notes/1275068

Updating Lumira Node
In this step, we are going to update the server that hosts Lumira Server add-on from version 1.3x to
Lumira Server 2.0 SP02 Patch1 add-on version;
Note: Note that we are using the ‘patch’ update as we’ve both Lumira 1.31 and Design Studio 1.6
in our landscape. But if you have only ‘Design Studio add-on, then you use the ‘full installer’. Refer
the following blog post for more information - https://blogs.sap.com/2017/05/19/updating-sapbusinessobjects-bi-platform-to-lumira-2.x/

Best practice alert: Before you start the update process, we strongly recommend you to make a
note of the folder where your Lumira 1.x documents are stored before performing the update.
Because you will need that info later to copy them post add-on update.

1. Download the ‘Lumira Server for BI Platform 2.0 SP02 Patch1 Update’ software package from
the software download center under ‘Support Packages and Patches’;
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Save it to a directory.
Note: We used Lumira 2.0 versions on this Pattern Book but if you want to use other Lumira
versions installers you may see the download instructions for Lumira Server and Clients here:
First at all, go the SAP Software Downloads page :
https://launchpad.support.sap.com/#/softwarecenter

Choose either: 1. “INSTALLATIONS & UPGRADES” or 2. “SUPPORT PACKAGES & PATCHES”.
Then you may select to search “By Alphabetical Index(A-Z)” and after that select the letter L.
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Here are the options you see for Lumira:

2. Extract the package and run ‘setup.exe’ as shown below;
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3. The installer will check the required pre-requisites. And this may require a system reboot and rerun the setup
4. The setup then continues with preparation step;

5. Accept the terms and continue;
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6. Enter system name, CMS port and admin credentials of the running CMS server (on the BI node);

7. Installation continues;
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8. Installation then finishes;
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9. Validate your installation by checking the programs and features;
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Updating Business Intelligence Node
In this step, we are going to perform the required updates to the server that hosts the core BI Services.
1. Using the same software package, update the BI node as shown below;

2. Accept the licensing terms and continue;
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3. The update process completes;
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Updating Web Node
In this step, we are going to perform the server add-on updates to the Web Tier node that host the
Apache Tomcat;
1. Run the update installer;
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2. Accept the terms and continue;
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3. Update completes;
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Installing Lumira Discovery Client
1. Download the Lumira Discovery client software as shown below;
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2. Extract it to a folder and run setup from DATA_UNITS folder;
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3. Specific the destination folder;
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4. Accept the licensing terms and continue;
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5. The installation completes successfully;
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Installing Lumira Designer
1. Download the Lumira Designer client and save it into the directory

2. Extract the installer and run setup. Simply follow the installation instruction;
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3. Specify the install location;
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4. Installation completes successfully;
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5. Launch the Lumira Designer and enter the system details;
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Objects Conversion
Planning your Conversion
Here are some thoughts around how to properly plan your conversion and important things to note
down.
**Note: While the scope of this entire pattern book is about updating the server add-on and
documents conversion with BI platform, the documents conversion part of the project can be done
independent of Lumira Server (add-on) upgrade (update).

Lumira 1.x content conversion planning
You may either rebuild all your Lumira 1 content in Lumira 2, or alternatively you can convert your existing
Lumira 1 content to Lumira 2. Lumira 1 documents using live connectivity to HANA cannot be converted
to Lumira 2, they must be rebuilt from scratch. If you decide you’d like to or are able convert your content
then you’ll need a Lumira 2 server ‘somewhere’ to assist with the content conversion, it could well be
Production system. A Lumira 2 server will be required, as only a Lumira 2 Discovery can connect to a
Lumira 2 server to store documents and to use the managed connections held within it. These managed
connections are fundamental to the conversion. You have a choice, either you
1. Update the Production system to Lumira 2, and then update your content. This would require
‘downtime’ for any Lumira 1 users as content will only be available after its been converted.
2. Or, promote the Lumira 1 content into a ‘Dedicated Conversion System’ with its own server and
client. Perform the necessary conversion there, validate it, and then once the Production System
has been updated, this ‘pre-converted’ content can immediately be promoted into Production
reducing downtime for Lumira 1 users to a bare minimum. This system can also be used to
develop changes to access rights introduced with Lumira 2.
Both options will require the system where to conversion is to occur be of Lumira 1 version 1.31.8 for both
client and server. Lumira 1.31.8 is required as only Lumira 1 document can be viewed by Lumira 2 when
saved in that version with a ‘for migration’ flag enabled.
For this pattern book, we have chosen option 1, to ‘Update in Production’ system rather than ‘Dedicated
Conversion System’. ‘Update in Production’ means firstly update to Lumira 1.31.8 for both server and
client, and then to update to Lumira 2.

Design Studio content conversion planning
Existing Design Studio applications of version 1.6.x should all work in Lumira 2 ‘compatibility’ mode as
they did before. Though there may be some minor cosmetic differences that could be expected in line
with a Support Pack update. However, any applications that use JDBC to HANA will need to be adapted
once the system has been updated to Lumira 2.
Note: It is not required to convert the Design Studio 1.x documents to access/run them on Lumira
2.0 landscape. However, if you intend to access/leverage 2.0 features/functionalities, then you are
required to convert the 1.x documents to 2.0.
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You’ll need a Lumira 2 server ‘somewhere’ to assist with the any application conversion, it could well be
Production system. A Lumira 2 server will be required, as only a Lumira 2 Designer can connect to a Lumira
2 server to store documents and to use the managed connections held within it. These managed
connections are fundamental to the conversion. You have a choice, either you
1. Update the Production system to Lumira 2, and then update your content. This would require
‘downtime’ for any Design Studio 1 users as content will only be available after its been converted.
We shall call with ‘Update in Production’.
2. Or, promote the Design Studio 1 content into a dedicated ‘Conversion System’ with its own server
and client. Perform the necessary conversion there, validate it, and then once the Production
System has been updated, this ‘pre-converted’ content can immediately be promoted into
Production reducing downtime for Design Studio 1 users to a bare minimum. This ‘Dedicated
Conversion System’ would also enable the validation of old Design Studio 1.x content works as
expected in Lumira 2. This system can also be used to develop changes to access rights introduced
with Lumira 2.
For this pattern book, we have chosen option 1, to ‘Update in Production’ system rather than ‘Dedicated
Conversion System’

Prepare Content
•
•
•

•

•

•

•

Identify Lumira 1 content that needs to be converted to Lumira 2.
Identify Design Studio content that needs to be adapted for Lumira 2. These will be applications using
JDBC to HANA. SAP Note 2512478 and 2475223
If planning to use a ‘Dedicated Conversion System’ then:
o Identify a system, potentially development, for where this content can be promoted to,
converted, and then promoted back into original system.
o Lumira 1.x or Design Studio 1.x server add-ons need to be installed to allow that content to
be promoted into it. https://blogs.sap.com/2017/10/04/promoting-design-studio-1.x-orLumira-1.x-content-into-Lumira-2-server/
o If Lumira 1 content needs to be converted, then Lumira 1.31.8 server add-on and clients will
need be installed before Lumira 2 is installed. Any Lumira server add-on before 1.31.8 isn’t
strictly necessary, but it is a best practice to ensure the same add-ons are installed in the same
order, so up to three Lumira add-ons may be required here.
Identify any Lumira 1 content that has any access rights on the individual document objects and make
plans to remove these and place the rights on folders. This is necessary, as once Lumira 2 has been
installed, the Lumira 1 content can no longer be managed in the Central Management Console and
the Lumira 1 content can be managed by security placed on folders and allowing inheritance to apply
to the individual Lumira 1 documents.
Identify any Lumira 1 that could be required to be deleted post update to Lumira 2. Plan to move this
Lumira 1 content into dedicated Lumira 1 folders, so the folders can be deleted post update, since
Lumira 1 content themselves cannot be individually selected for deletion.
Identify and plan any BI Platform updates. Need to check and validate the Lumira 2 PAM with the
current installed version and there may be a requirement to update the BI Platform to a supported
version before installing Lumira 2.
Identify if any new license keys are required.
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o
o

o
o

Lumira 2.0 Discovery installer comes with a 30-day trial license. After that expires you need
to update the keycode for it to continue working.
Lumira Discovery 2.0 keycodes are different from Lumira 1.x keycodes. Your Lumira 1.x
keycode will not work in Lumira Discovery 2.0. To request a new license key, refer to SAP note
2519499.
Lumira Designer 2.0 and Lumira Server 2.0 do not require license keys.
For more information on licensing see this blog - https://blogs.sap.com/2017/05/04/Lumira2.0-and-licensing/.

Conversion of Lumira 1.3x Documents
Before you start the conversion, connect to the BI Platform. You will notice that the .LUMS documents
are not visible/available in the folder. That’s because Lumira 2.x server add-on doesn’t understand Lumira
1.x format, post upgrade (update). Therefore, it is important to convert the 1.x documents to 2.x format
to consume them.
Best practice alert: Before you start the update process, we strongly recommend you to make a
note of the folder where your Lumira 1.x documents are stored before performing the update.
Because you will need that info later to copy them post add-on update.

Conversion of .LUMS files in Lumira Desktop 1.31.8
1. Launch Lumira desktop 1.31.8 and connect to the BI platform, which has been updated to
Lumira Server 2.x as shown below;

2. You will get the warning message about version difference. Accept and proceed further;
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3. Upon successful login, you will see all the .LUMS documents as shown below;

You should now know how to retrieve the .LUMS documents after the server add-on update.
4. Open .LUMS file in Lumira Desktop 1.31.8;
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5. Go to “File” -> “Save for Migration”;
(Refer this note for conversion details – https://launchpad.support.sap.com/#/notes/2509882)

6. Choose Local to save the .LUMS which is ready to be converted in Lumira Discovery
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7. You will receive an error if you want to save it back to BIP
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8. Original .LUMS file will be replaced in the local Lumira desktop repository

9. Continue
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Conversion of .LUMS files in Lumira Desktop 2.0 SP02 Patch1
1. Import the .LUMS file to Lumira Discovery

2. Choose the .LUMS where it was being saved to
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Note: If Lumira Desktop and Lumira Discovery are installed side-by-side, then import is not necessary.
Because the users can open the .LUMS file, which has been saved for migration in Lumira Discovery
home page under Local Document -> Lums Document

3. After the document is imported, it would be opened automatically in Lumira Discovery
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4. Go to File -> Save As

Select “SAP BI Platform” and provide the Server to connect and CMS credentials then hit “Connect”
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Navigate to the destination folder, select it and Save the document.

5. Click OK to confirm
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6. Confirm again

7. Lumira doc in .lumx format should be published back to BIP successfully

And a local .LUMX file is created locally on the Lumira repository
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8. Check in BI Launchpad and find the Lumira report is visible and in .LUMX format

9. View the .LUMX doc in BI Launchpad
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10. Check in CMC and find the Lumira report is visible and in .LUMX format

Conversion is Done.
**Note: Make sure to refer the SAP Notes 2509882 and 2538142 before converting your Lumira
Documents. More details about these notes are available in the Useful Resources > SAP Notes
section of this book.
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Conversion of Design Studio 1.x Documents
Note that the conversion of Design Studio 1.x documents is performed in Lumira 2.0 Designer tool. It is a
recommended approach due to the changes in Design Studio versions 1.6 and 2.0.
Note: Make sure to refer the SAP Note 2538142 https://launchpad.support.sap.com/#/notes/2538142 to learn some aspects around Design Studio
documents conversion

Conversion Steps
These are the steps followed in sequence for the successful conversion of Design Studio 1.x documents
to Lumira 2.0;
1.
2.
3.
4.
5.
6.
7.
8.
9.

Preparing Lumira Designer for Conversion
Importing Design Studio Applications
Setting the SAPUI5 m Mode
Exporting the Design Studio Applications
Switching Lumira Designer to Lumira Document Mode
Creating Lumira Document
Importing Design Studio Applications for Conversion
Synchronizing changes with BI Platform
Conversion Validation

Now, let’s look how these steps were executed in the test environment.

Preparing Lumira Designer for Conversion
In order to prepare the Lumira Designer for conversion, make sure to run it in BI platform legacy mode
first;
1. Open Lumira Designer and run as administrator;

Provide the login credentials to connect to SAP BI Platform Server.
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Lumira Designer loads with a splash screen as below
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Upon loading, choose Tools > preferences

The default startup mode is “SAP BusinessObjects Lumira Documents”. For performing document
conversion, you will need to change this to “SAP BusinessObjects BI Platform (Legacy)” mode and click
ok.
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This prompts you to restart Lumira designer. Choose yes.
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Login to BI platform again when prompted

Close (red x) the default welcome tab to reveal the designer panels
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Importing Design Studio Applications available on local drives into BI platform
Note: In this scenario, we assume that you have exported design studio applications as .ZIP files using
SAP Design Studio into a local folder. If you already have your Design Studio applications in the BI Platform
then you may skip this section.
On Lumira Designer, Click on the following menu option: Application> Import

Choose to Browse, navigate and pick the legacy design studio application to be converted to Lumira 2.x.
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Click Next;
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Choose the target folder in BI platform. If the file already exists, you can choose to overwrite later if
desired.
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After choosing target folder in the BI Platform
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Choose a location to import the referenced files having clicked on browse option as shown below. Once
done, Click Next.

63

Choose to map any backend / database connections by clicking on the dropdown arrow and choosing to
browse connections.

Map connections by choosing the relevant connection as shown below
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Click next after confirming the connection has been mapped as below

Review the summary and click Finish
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A status window will show the import processing as below

Legacy Warning: you will get warnings as below indicating that the Design studio application is a legacy
or 1.x application. Click ok and proceed with the import and open the imported application.
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Setting the SAPUI5 m Mode to true
Upon importing a legacy Design studio application, it shows that the “SAPUI5 m Mode” is false which
means it is not yet ready for conversion as shown below;

To convert to Lumira, the DS application will need to be migrated to “SAPUI5 m Mode” as shown below.
Click on Tools > Migrate to SAPUI5 m Mode

The application will refresh and reload

67

Upon loading, you will notice that SAPUI5 m Mode is True.

Save the document to BI Platform
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You will get Legacy warnings that the application will be incompatible with older tool versions.
Click Save.

Upon saving, you will now be able to see the Design Studio applications on the BI platform when viewed
in BI Launchpad
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Exporting the Design Studio applications into a local folder for Lumira conversion
Choose to export the “migration enabled” design studio application as shown below -
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Follow the export application wizard and choose the folder to export as desired
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After export, the “ready to be migrated” Design Studio application is exported as a .ZIP file into the
folder specified.
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Switching Lumira Designer to Lumira Document mode
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Creating a Lumira document
Under BI Platform, create a Lumira document under a desired BI platform folder location as shown
below.
At this point, this is just a blank document which will be used to import the design studio application.
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Importing the DS application for conversion
On Lumira designer, Choose the Lumira document (blank) that was just created,
Right-click on it and choose to Import Application.
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Navigate to the local folder where you have earlier saved the “to be converted” DS application .ZIP file,
and choose to Open as shown below.

Follow the Import Application wizard directions as shown below -
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Provide relevant folders for referenced files.
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Map connections where required.
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Click Finish.
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C

You should get a message that import finished.

The design studio application displays as a Lumira document in the designer.
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Synchronize changes with BI platform
After import, the Lumira document warns of unsynchronized changes in the BI platform

This may cause the Lumira documents to not be viewed properly In BI Platform.
To resolve the issue, you need to synchronize the changes with BI platform as shown below.
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With this step, Design Studio to Lumira document conversion is completed.

Validation on BI Launchpad
You should be able to see the converted Lumira document (LUMX) alongside the design studio
application before conversion.
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Right-click and choose View the converted Lumira document to open in BI Launchpad web interface.

The document opens as shown below.
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Here is the chart view.
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Things to do Post Update and Conversion
There are couple of things to do once you update the server add-on and complete the objects
conversion.

Server administration
•

BI Platform Processes
o Remove Design Studio Adaptive Processing Server service and replace with the new Lumira
Server service
o Potentially start and stop other services. Please refer to
https://wiki.scn.sap.com/wiki/x/Vw57H for detailed understanding for which process is
used when and a summary at https://blogs.sap.com/2017/10/19/lumira-2-workflows/
▪ For example, DSL Bridge is no longer used, whereas the WACS may now be a
requirement. The ‘Connection Server’, if used by Lumira, would be best to run on
the machine(s) running Lumira in addition to their current location(s).
o In general, a review of BI Platform Services configuration may be required. For example, if
both Lumira 1 and Design Studio 1 was used on the server previously, these two separate
services are now processed by the same service. So potentially additional services may be
required, or moved to run on a different machine.

Managing Objects
•

Manage Lumira 1 content
o Optionally delete the Lumira 1 content by deleting the dedicated folders they are held in.
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Issues and Challenges
Here are some of the issues and challenges that we faced while attempting to update the server add-ons
and converting the 1.x documents to 2.0 version;

Lumira Server Running with Errors
Issue Description: Lumira server running with errors after updating Lumira add-on version 1.3x to 2.0.
In a distributed deployment, with a separate BI server node and Lumira node, after installing the Lumira
server add-on, you may notice that Lumira server is “running with errors” as shown below;

Cause: You may see the install logs showing success and no failures. But we collected the install, Lumira
logs and troubleshoot the issue, there seem to be failures on JAR files Eg: Bundle "com.ibm.icu" version
"4.4.2.v20110823" has already been installed from: reference:file:/C:/Program Files (x86)/SAP
BusinessObjects/SAP BusinessObjects Enterprise XI
4.0/java/pjs/container/../services/TeamServerPJSService/lib/com.ibm.icu_4.4.2.v20110823.jar or
/C:/Program Files (x86)/SAP BusinessObjects/SAP BusinessObjects Enterprise XI
4.0/java/pjs/container/plugins/bnd.jar.
Resolution: A dependent jar file i18n.jar file was missing. The solution is documented in SAP Note
2220461 - Lumira Server for BI Platform displays a status as "Running with errors" in the Servers Page of
Central Management Console (https://launchpad.support.sap.com/#/notes/2220461)
Note: This is the main reason why we had to install the full stack of BI Platform on the Lumira Node (as
you saw in the note under system architecture section of this book). Again, though you install the full
stack, you are only required to run Lumira Server, AJS and WACS.
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Uploading Lumira Samples Takes Longer Time
Issue Description: Uploading Lumira Samples takes longer time and eventually you may experience that
the samples are not uploaded in distributed Lumira add-on installation.
Cause: We noticed that this step took longer time (about 30 mins) and even after that, the samples were
not loaded due to potential product issue.

Resolution: This seems to be seen in distributed deployments possibly due to missing dependent
components. To resolve, promote these samples over from a standalone server installation (if you
have) with a full stack where the samples will be available.

Assertion Failed Error
Issue Description: Assertion failed error when you attempt to perform a modify or repair or remove
Lumira server add-on.
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Cause: This is due to a known limitation with the Lumira Server add-on installer, which is currently under
investigation by product development.
Resolution: We would recommend you to refer the following SAP notes;
2523946 - Uninstalling Lumira Server 2.0 Patch 02 results in error: Assertion Failed Microsoft Visual C++ https://launchpad.support.sap.com/#/notes/2523946

2477140 - Assertion failed - Visual C++ Runtime Library error on installation of BI Add-ons https://launchpad.support.sap.com/#/notes/2477140

2467541 - Supported BI Platform Add-On versions information for the SAP BusinessObjects BI 4.2 SP04 https://launchpad.support.sap.com/#/notes/2467541

The crystalEnterprise.LUMX plug-in does not exist in the CMS FWM 02017
Issue Description: We experienced this error while trying to save .LUMX document to the BI platform.
Cause: SAP BusinessObjects Lumira application default object (DFO) does not get uploaded from Lumira
node. In distributed environment, after updating Lumira Node from Lumira server 1.x to 2.0 SP2, we ran
into this issue where we could not see any .lumx samples or save a sample .lumx file to BI platform.
Resolution: This is how we fixed this issue;
1. On the Lumira Node, you will find a file the
C:\Program Files (x86)\SAP BusinessObjects\setup\packagestemp\BusinessObjects_LumiraApp_dfo.xml
2. Copy this over to the BI Node into same location
C:\Program Files (x86)\SAP BusinessObjects\SAP BusinessObjects Enterprise XI
4.0\packages\BusinessObjects_LumiraApp_dfo.xml file
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BusinessObjects_LumiraApp_dfo.xml
3. Restart BI Node SIA. This should upload this file and establish the LUMX plugin.

Post update, unable to see .LUMX documents
Issue Description: After performing the add-on update, we could not see any, LUMX documents in BI
Launchpad or Promotion management however, those same documents were visible in the CMC. This
symptom was noticed even with Administrator user.
Cause: We suspect this issue has something to do with web tier deployment, especially when you have
the their deployed on a dedicated server.
Resolution: Redeploying the BOE.war file webapp from a full stack system.

Post Update, opening Lumira documents displays 404 error pop-up
Issue Description: Issue # 5 - Opening a Lumira document via CMC or BI Launchpad OR creating a new
Lumira document in BI Lauchpad gives a 404 error POP UP.
Error Message: log4javascript error: AJaxAppender.append: XMLHttpRequest request to URL
/BOE/portal/1705041626/ LumiraWebApp/h5v2/service/writeLogMessages
returned status code 404.
Cause: This is a known issue that is fixed in Lumira Server 2.0 SP03.
Resolution: Although the error Pop Up occurs, you can still click OK and open the Lumira document. For
more details, refer this SAP note - https://launchpad.support.sap.com/#/notes/2547126
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Useful Resources
SCN Blog Posts
Title & Author:
URL:
Abstract:

Getting started with SAP Lumira 2.0 by Ramu Timma Gowda of SAP Labs.
https://blogs.sap.com/2017/09/21/getting-started-with-sap-Lumira-2.0/
In this blog post, Ramu provides a high-level overview of SAP Lumira 2.0 with key
information around the supported platforms, release notes, software & license key
download instructions, integrating with BI platform and important things around
converting 1.x objects to Lumira 2.0 format.

Title & Author:

What’s New with SAP Lumira 2.0 Launch blog series by experts from SAP and SAP
Customer.
https://blogs.sap.com/2017/04/18/whats-new-with-sap-businessobjects-Lumira2.0-launch-blog-series/
There are 30+ blog posts available in this series authored by experts from across
SAP and a customer. The topics ranging from introducing Lumira 2.0 to every
important topic around licensing, deploying, using and integrating Lumira with BI
platform are discussed in this blog series.

URL:
Abstract:

Title & Author:
URL:
Abstract:

Title & Author:
URL:
Abstract:

Updating SAP BusinessObjects BI Platform to Lumira 2.x by Matthew Shaw of SAP.
https://blogs.sap.com/2017/05/19/updating-sap-businessobjects-bi-platform-toLumira-2.x/
In this blog post, you will find Matthew explaining the important aspects around
how to successfully update your Lumira Server for BI Platform from 1.x version to
the latest 2.0 version and what to watch out for when it comes to converting your
1.x documents.
You can read this as a prelude to the SAP BI Pattern Book on Lumira 2.0.
Lumira 2 Workflows by Matthew Shaw of SAP.
https://blogs.sap.com/2017/10/19/Lumira-2-workflows/
In this blog post Matthew provides the preview of the 26 workflows diagrams that
he created and published. If you are looking for info around which component is
used on what process etc., then there you go – these workflow diagrams will walk
you through the entire process in an easy to follow and understand manner.
The link to the main SCN WIKI page is this - https://wiki.scn.sap.com/wiki/x/Vw57H.
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SAP Notes
Here is the list some important, relevant SAP Notes on SAP Lumira 2.0;
SAP Note Number:
URL:
Abstract:

SAP Note 1275068
https://launchpad.support.sap.com/#/notes/1275068
This SAP note explains the Backup & Restore processes for BI platform,
which is very important step to perform before running the add-on server
upgrade (update).

SAP Note Number:
URL:
Abstract:

SAP Note 2462799
https://launchpad.support.sap.com/#/notes/0002462799
This is the master release note for SAP Lumira 2.0, which includes download
instructions and a master list of SAP Notes.

SAP Note Number:
URL:
Abstract:

SAP Note 2519499
https://launchpad.support.sap.com/#/notes/2519499
This SAP note provides information about license keys for SAP
BusinessObjects Lumira Discovery 2.0 SP02.

SAP Note Number:
URL:
Abstract:

SAP Note 2512478
https://launchpad.support.sap.com/#/notes/2512478
This SAP note covers the differences between the JDBC connectivity option
to SAP HANA versus the new InA based connectivity introduced in SAP
Lumira 2.0.

SAP Note Number:
URL:
Abstract:

SAP Note 2475223
https://launchpad.support.sap.com/#/notes/2475223
This SAP note covers the step-by-step process to change a HANA JDBC
connection to InA connection in Lumira 2.0.

SAP Note Number:
URL:
Abstract:

SAP Note 2509882
https://launchpad.support.sap.com/#/notes/0002509882
This SAP note details the steps required to convert Lumira Discovery and
Lumira Designer documents.

SAP Note Number:
URL:
Abstract:

SAP Note 2458156
https://launchpad.support.sap.com/#/notes/2458156
Refer this SAP note for additional requirements, if you plan to use LCM with
both Designer and Discovery documents.

SAP Note Number:
URL:
Abstract:

SAP Note 2525751
https://launchpad.support.sap.com/#/notes/2525751
This SAP Note can help/guide you diagnose those issues that might occur
when attempting to connect Lumira Discovery to the BI Platform.
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SAP Note Number:
URL:
Abstract:

SAP Note 2462202
https://launchpad.support.sap.com/#/notes/2462202
This note explains the release restrictions for Lumira Discovery and Server 2.0
SP2.

SAP Note Number:
URL:
Abstract:

SAP Note 2507011
https://launchpad.support.sap.com/#/notes/2507011
This SAP note details the release restrictions for Lumira Designer 2.0 SP2.

SAP Note Number:
URL:
Abstract:

SAP Note 2571105
https://launchpad.support.sap.com/#/notes/2571105
This SAP note explains the Lumira samples are not being visible on BIP
platform, post installation
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